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1 Introduction 
This handbook provides instructions and tips to trainers of the INTUX training 
material. It is divided into two parts. 

The first part (chapters 2-6) focuses on ensuring an accessible and inclusive learning 
environment for all students, covering both online and face to face learning 
environments. It provides guidance on how to prepare the classroom to make it 
accessible, choosing the most appropriate online collaboration tools, how training 
material can be made accessible and teaching strategies for inclusive training. 

The second part (chapters 7-8) focuses on specific trainer tips to teach the content 
included in the training modules. It provides background information on the material 
that is being taught and include prompts for group discussion on key points in the 
materials. 

The aim of the handbook is to prepare the trainers to be able to successfully teach 
the course on inclusive and accessible user testing by highlighting the different 
aspects that should be considered. 

1.1 Target audience 

The handbook has been primarily conceived for university teaching and training staff 
who design and or deliver education and training in User Experience (UX)-related 
subjects. However, many of the recommendations can also be applied in other 
educational contexts for professional UX training, such as in vocational education and 
training (VET) courses and life-long learning processes. 

The overall aim is to make it easier to start making the connection to users with 
disabilities in all UX related courses, and to include the basics of user testing with 
persons with disabilities in courses made available for all students. The project 
partners therefore hope that the handbook and training material will be of interest to 
anyone interested in user-centred design in the broad sense. 

An important part of teaching this subject is that the trainers have knowledge of 
accessibility and be able to provide an accessible training. It is crucial that they 
receive institutional support and help to make their course and training material 
more accessible. 

1.2 A flexible approach to learning 

The INTUX training modules have been designed to be as flexible as possible for the 
training organisation implementing the programme. 

• Online or face to face: The training materials have been designed in such a 
way that they can be taught face to face, online or through blended learning. 
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• Diverse target audience: Different organisations implementing the training 
may have different priorities regarding the target audience and varying set 
ups, prerequisites, backgrounds, and resources. The materials have therefore 
been produced as a baseline that can be flexible and dynamic and moulded to 
suit the best interests of each training organisation. 

• Guided or self-learning: The training modules can be used for both guided 
and self-learning or a mixture of these two approaches. 

• Stepwise approach: The training modules are developed to follow the logical 
steps of preparing, carrying out and following up usability testing. Trainers are 
recommended to use the modules in this order, however it is possible to 
select one or two modules only, or to choose another order altogether. 

• Flexible duration: There is no proposed duration of the training programme 
because this would differ depending on the organisation implementing the 
training and on their specific needs. The duration should be sufficient so as 
not to overload the participants in the training course. It should also be 
adapted according to the type of participants being addressed. 

1.3 Set-up of training modules 

The five modules are: 

• Foundational: Planning, flexibility and back-up/alternatives. 

• Test panel set-up and diversity: What to think about when setting up your 
test panel and recruiting participants. 

• Communication and etiquette: What you need to know about disability 
etiquette and how to communicate in an inclusive way. 

• Assistive technology, guidance, and support: How to support and guide users 
that uses assistive technology. 

• Conclusion of the test, feedback and compensation: Important aspects to 
think about after conducting a test. 

Each of the training modules consists of the same categories of content: 

• Prerequisites 
o For students 
o For instructors 

• Learning outcomes for the module 
• Training content 
• Examples of exercises 
• Learning assessment methodology 
• Links to further resources 
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1.4 Face to face or online 

In light of the recent global challenges presented by the Covid-19 pandemic, many 
training institutions have adapted their approach to online education, providing 
students with the flexibility to choose the training format that best meets their 
preferences: face-to-face, online, or hybrid. This flexibility can be very positive for 
students with different abilities, however it also puts more pressure on trainers to 
understand and handle not only the pedagogical aspects but also a variety of possible 
technology and accessibility issues. 

This handbook describes some of the main aspects that need to be considered when 
preparing a face-to-face training programme as well as online training. 

2 Disability etiquette 
2.1 What is disability etiquette 

Disability etiquette entails treating, communicating with, and speaking about 
individuals with disabilities in a respectful and considerate manner. Many disabilities 
remain hidden, and, upon reflection, you will likely recognize the variations in 
abilities among your friends, family, and colleagues. Just as you expect others to 
respect your needs and preferences, disability etiquette involves making an effort to 
honour those of others. 

Practicing disability etiquette serves to break down stereotypes and eliminate the 
stigma surrounding disabilities, fostering a society that values diversity and embraces 
empathy. By adhering to these principles, individuals can create an environment that 
welcomes and supports people with disabilities, allowing them to fully participate in 
society. 

It is essential to remember that people with disabilities constitute the largest 
minority in the world, and their needs and preferences are as diverse as those of any 
other group of individuals. 

Here are four fundamental recommendations to guide your interactions: 

 Address the person with a disability directly, rather than speaking to their 
caregiver or assistant. 

 Avoid making assumptions about what someone can or cannot do. 
 Always ask if the person needs assistance before offering help. 
 Respect personal equipment and assistive technology, avoid petting a service 

dog while it is on duty. 

2.2 Be Attentive 

Individuals with disabilities are the best judges of their abilities. Respect their ability 
to make choices for themselves and avoid making assumptions based on 
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appearances. For instance, some blind individuals prefer to navigate new 
environments independently, while others welcome guidance. People who use 
wheelchairs or walkers may use their assistive technology regularly or occasionally. 
Similarly, individuals who appear mobile may struggle with long-distance walking due 
to hidden medical conditions. 

While it may seem tempting to offer assistance, it is crucial to let individuals 
determine their needs for themselves. Some prefer independence, while others 
welcome help. The key is to be attentive, ask politely, and respect their response. 

Do not assume that individuals view their disability as a misfortune. 

2.3 Guidelines for Social Interactions 

In social interactions, strive for communication on equal terms. For example, when 
speaking with someone in a wheelchair, position yourself at eye level to reduce social 
disparities caused by height differences. Or provide real-time captioning during a 
team meeting to allow individuals with hearing impairments engage fully and equally 
with their colleagues. 

Be aware that noisy or distracting environments can be particularly stressful or 
impossible for individuals who are hard of hearing or have difficulty concentrating. 

Here are additional pointers for inclusive interactions: 

 Avoid interrupting or finishing another person’s sentences, which is especially 
important for those with speech impairments or stutters. 

 Be patient when waiting for a response to a question or direction, as 
processing information may take more time than you realize. 

 Instead of repeating, rephrase sentences if the person does not understand, 
which is particularly crucial for those with hearing impairments. 

 Do not assume a person is not paying attention just because they are not 
making eye contact while you speak. 

 If you have difficulty understanding someone’s speech, give them your full 
attention, and, if necessary, ask for clarification or suggest alternative 
communication methods. 

When interacting with individuals who are deaf or hard of hearing, establish visual 
contact and face them directly, as many rely on lip-reading. When using a sign 
language interpreter, address the person who is deaf directly, not the interpreter. 

When meeting someone who is blind, introduce yourself and inform them when you 
leave the conversation or the room. When offering guidance, offer your arm instead 
of grabbing theirs, and provide descriptive information about the surroundings. 
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2.4 Words and Terminology 

Language carries power and can reflect how we perceive others. While terminology 
preferences may vary, here are some general recommendations: 

 Use "person with a disability" instead of "disabled person". 
 Avoid outdated terms like "handicapped," "crippled," or "retarded," as well as 

euphemisms like "physically challenged" or "differently abled". 
 Refrain from using disempowering words like "victim", "sufferer" or "suffers 

from". 
 Avoid referring to individuals by their disabilities; instead, say "She has 

epilepsy" rather than "She is an epileptic". 

2.5 Inclusive Language and Images 

People with disabilities are just as diverse a group as any other. It is important that 
the expressions we use, and the images we show to accompany our words or to 
facilitate the understanding of the content, do not promote stereotypes. It is 
therefore important to reflect the social diversity that exists among the different 
persons with disabilities. You should pay attention to represent the variety in gender, 
size, age, socio-ethnic background, sexual orientation, religious beliefs, place of 
residence (rural or urban), and so on. 

• Be respectful with persons with disabilities, just like with other people. 
Disability etiquette explains what to pay attention. 

• All persons have different abilities, and all persons with disabilities are 
different. Be attentive: follow their preferences, just like you would do with 
any person. 

• Adjust your interaction to the situation of the other person. Don’t be 
impatient or paternalistic. 

• Use respectful terms when referring to persons with disabilities. 

• As always, acknowledge your audience: consider the abilities of the other 
person and communicate in a way that they fully understand you. 

3 Face to face training: considerations for accessibility 
When planning a face-to-face training program or individual sessions, several crucial 
aspects must be considered to include students with disabilities in the training 
sessions. 
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3.1 Ensuring access to the venue 

Ensuring that your participants can easily access the training venue is essential. If you 
have prior knowledge of your participants, you can ask for their preferences and 
provide information tailored to their needs in the format they prefer. However, when 
you are not familiar with your audience, it is crucial to make the information 
accessible in terms of content and format. 

When describing directions to the training venue, try to avoid relying solely on visual 
cues. It is often better to say, "Take the second street on the left" rather than "Turn 
left at the big red house." Furthermore, describe the road surface, whether it is 
asphalt, a sidewalk, or a path with sand or gravel. If possible, provide directions that 
support audio and tactile orientation. For instance, walking alongside a building is 
usually more straightforward than crossing an empty square. 

Additionally, specify if there is reserved parking for community transport like taxis or 
buses, as well as parking for people with disability permits, and indicate how far 
these spaces are from the entrance. Ensure entrances and directions are clearly 
marked with large, high-contrast signs and include illustrations for cognitive support. 
Note that Braille may not be effective outdoors, so tactile elements in the signs can 
enhance visibility. Place signs at a distance where the next one is visible from the 
previous one or provide directions to the next sign’s location. 

Finally, ensure that stairs and other obstacles are marked with high-contrast 
markings for improved accessibility. 

3.2 Inside the building 

Within the building, make glass doors and transparent items clearly marked to 
prevent harm to visually impaired users. When guiding participants through the 
building, ensure that the path from the entrance to various rooms, including the 
training room, restrooms, wardrobe, kitchen, and coffee service areas, is obstacle-
free. Provide descriptions of the path in the materials given to participants. 

To enhance accessibility, remove loose objects and ensure there are obstructions 
under hanging cabinets and shelves to prevent visually impaired individuals from 
bumping into them. Mark routes and stairs with high-contrast markings and large 
signs. In larger buildings, consider providing large-print or tactile maps and, if 
possible, offer a guide until the route is memorized. 

3.3 Setting up the room 

In the training room, allow participants to choose their seating positions. Recognize 
that visually impaired and hearing-impaired individuals may have different 
preferences for seating arrangements. Some may prefer to sit at the front, and some 
might have varying personal preferences for lighting and board angle, depending on 
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the specific impairments. For instance, participants with macular conditions may use 
peripheral vision, making them appear as if they are looking out the window. 

When speaking in the training room, avoid standing in front of strong light sources, 
such as windows, as this can cast shadows and obscure your facial expressions. To 
improve visibility, use contrasting colours for the frames of whiteboards on white 
walls, and select markers that contrast well with the board. Be mindful of lighting and 
reflections, both natural and artificial, on whiteboards. 

Maintain appropriate lighting levels, ensuring that the general lighting is bright, warm 
and even, and avoids glare. If necessary, provide individual task lighting. Good 
acoustics are essential for all participants, especially those with hearing impairments. 
Minimize background noise and require participants who use screen readers or other 
audible assistive technology to use headphones in larger rooms. 

In larger rooms, consider using microphones, speakers, and induction loops for better 
sound quality and accessibility. 

• Make sure that participants can get to the training venue. Provide route 
guidance (both format and content) that is accessible for persons with any 
abilities. Mark any obstacles in the way. 

• Use signs that are well visible to indicate the way to the classroom in the 
building and also provide guides. Make sure that the path has no 
obstructions, and mark any possible obstacles you cannot remove. 

• Set up the classroom so that people can choose their ideal seating. Be 
mindful of proper lighting and acoustics. 

4 Online training 
4.1 Video conferencing and collaboration tools 

One of the most critical decisions in the realm of online training revolves around the 
choice of video conferencing and collaboration tools. Choosing the right video 
conferencing and collaboration tools is a pivotal decision for online training. It is 
recommended to carefully review the accessibility statement of any tool under 
consideration and to explore recent online discussions and recommendations before 
making a final selection. 

The goal of this chapter is not to endorse a single, specific video conferencing tool. 
The landscape of these tools is continually evolving and updating, often improving 
accessibility, but occasionally introducing new challenges. 
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An inclusive video conferencing tool should inherently encompass features such as 
integrated closed captioning, the capacity to spotlight sign language interpreters, and 
seamless compatibility with assistive technology for both input and output, thus 
ensuring that it caters to the diverse needs of all users. 

Examples of online video conferencing tools providing basic accessibility features at 
the date of creation of this handbook, in alphabetic order: 

• Google Meet 
• GoTo Meeting 
• Microsoft Teams 
• Slack 
• Webex 
• Zoom 

It is important that the students know well in advance which platform will be used for 
the online training, so they have time to do the necessary preparations. Additionally, 
it is useful to make available accessible information with guidance or a manual, on 
how to access the platform, ideally provided by the training organisation (university). 
For example, a document in easy read, with the steps to follow to connect and use 
the platform, accompanied by screenshots. 

4.2 Conducting an online training 

Online meetings can often be quite exhausting due to the limitations in seeing and 
interacting with other participants compared to the dynamics of face-to-face 
meetings. Consequently, it is crucial to acknowledge this fact and proactively 
incorporate regular breaks into your agenda. Furthermore, active engagement with 
participants by pausing, asking questions, or conducting exercises becomes essential. 

This is important for all students but maybe even more important for students with 
different types of disabilities. 

Before starting the online training sessions, we suggest considering the following 
points: 

● Time management and pace: If the training or discussion moves too quickly, 
it can be inaccessible to some students. When using videoconferencing tools, 
like the ones mentioned previously, various challenges may arise, including 
audio, visual, and chat issues. It is important to be mindful of these potential 
problems and adjust the pace according to the needs of your group. 

o Check in on people’s understanding throughout the training and 
reiterate key points at regular intervals. 

o Ensure that participants speak one at a time. 

https://meet.google.com/
https://www.gotomeeting.com/
https://www.microsoft.com/en-us/microsoft-teams/group-chat-software
https://slack.com/intl/en-es/
https://www.webex.com/
https://zoom.us/
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o Ask students to request their turn to speak by using the “raise the 
hand” function (or similar) or by alternative ways such as the chat box. 

o Record the meeting (always seeking prior permission from all 
students). This can be shared afterwards and will allow participants to 
go back and listen to the important points again afterwards. 

o Ensure that you include the appropriate number of breaks for long 
sessions. 

It is important that students understand the schedule of the course and the 
evaluations, that they can anticipate them and be well informed about any 
changes. 

o Provide in advance the evaluation criteria and the schedule of the 
periodic follow-ups measuring the students’ achievement, so that the 
students know what is expected. 

o Share information in advance about the type of format used to 
evaluate the students. 

o Set-up a calendar (by trimester or by month if necessary) to help 
understanding the schedule, reflecting school and vacation periods, 
marking important exams/tests. It may also mark the relevant study 
periods, to assist students in the planning. When changes occur, it is 
important to reflect them in the calendar. 

o Provide advance, written information about the activities planned, as 
well as timely information about any changes or cancellations. 

o Ensure that the changes are understood by the students. 

● Audio: An online training session involving many students may be noisy and 
quite hard to follow. 

o Consider using an external mic if you are hosting the meetings in order 
to improve sound quality. 

o Speak clearly and try to limit background noise. 

o Use a video conferencing system that supports closed captions and/or 
transcripts and turn on closed captions (many of the conferencing tools 
offer auto-captions). 

o Ask students to turn off their audio when they are not speaking. 

o Ask participants to introduce themselves when starting to speak. 
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o If you are using slides, try to share your notes or transcript so that 
students can read along as you present. 

o Allow transcript to be used for students who need it. 

● Visual: Visual images on slides are helpful, especially for those who need 
support reading or communicate through images or pictures. However, it is 
also essential, beyond providing alternative text descriptions for images, to 
verbally explain both the slides and the images for students who are unable to 
see them or cannot see them well. 

o Share any documentation that will be presented prior to the training, 
so students have time to go through it beforehand and use them 
during the training. 

o When using slides, read out the content of the slide and describe 
meaningful images. 

o Ask participants to introduce themselves when starting to speak. 

o If you are sharing a website, include the link to the website in the chat 
so students can access and read through themselves. 

● No online access: not everyone has an internet connection at home, or some 
people may live in rural areas where the connection is too weak to support 
video conferencing facilities. In these cases, it is important to offer an 
alternative, such as joining by phone. 

• Choose the right online tools for your classes, making sure they have the 
required accessibility features. Ensure that the students know in advance 
about the choice of tools. 

• Adjust your online training: make it interactive, insert breaks, make sure that 
every student can follow it, that they understand what is spoken and what is 
shown. 

• Share information about the organisation of the course in advance, so 
students can prepare for it. 

5 Accessible training material 
5.1 Information formats 

Users with diverse abilities often have varying preferences for how they access 
information, such as black print, large print, Braille, text accompanied by illustrations, 
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icons and similar to support understanding, audio, or various digital formats. Ensuring 
that the original digital source is accessible serves as a foundational step in 
simplifying the process of converting content into the desired format. 

Information presented solely on paper should typically be avoided, except when 
specifically requested by a student, as it can present significant challenges or even be 
entirely inaccessible to users who depend on assistive technology for reading. 

Similarly, when limiting the format, for example for how an assignment is expected to 
be delivered, it is important to propose alternative means and formats that the 
students can use. 

Here are some fundamental accessibility principles to keep in mind when creating 
your informational materials: 

• Use clear, consistent layouts for presenting content. This can be achieved in 
part by consistently using templates in word processing software, 
presentation software, content management systems and learning 
management systems. Consistent layout is important for all users, but 
essential for people with cognitive impairments. 

• Use correctly nested headings to structure documents. Word processing 
software such as Microsoft Word provides styles for headings. Using these 
heading styles has several benefits: apart from ensuring a consistent visual 
layout of the headings, they allow users with assistive technology to navigate 
the document by jumping from heading to heading, they allow you to 
automatically generate a table of contents, and they can be used to generate 
a hierarchical list of bookmarks when you export the document to PDF. 

• Use descriptive link text for hyperlinks. Use “Web Content Accessibility 
Guidelines 2.1” instead of “click here” or the document’s URL. This is useful 
for all users but essential for users with assistive technology. 

• Avoid creating PDF documents. Use HTML for presenting learning content in 
a learning management system. HTML is much easier to make accessible than 
PDF and can be easily adapted in the browser to fit the learner’s needs or 
preferences. Another option is to publish the content in ePub format, as an 
accessible e-textbook. PDF can be provided as a secondary format; in which 
case it should still meet accessibility criteria. This is again important for all 
users but essential for users of assistive technology. 

• Provide text alternatives for images and other non-text content. A text 
alternative should serve the same purpose as the non-text content. A short 
text alternative (e.g., for simple images) can be added as a type of metadata 
that is not visible to sighted users. Longer text alternatives (for complex 

https://www.w3.org/TR/WCAG21/
https://www.w3.org/TR/WCAG21/
https://www.w3.org/TR/WCAG21/
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images or diagrams) can be provided in text since they can also benefit 
sighted users. 

• Use highly legible fonts and plain backgrounds. A font size of 12 points or 16 
pixels is recommended. Sans-serif fonts that were designed for reading on 
screens include Verdana, Trebuchet MS and Calibri. Serif fonts designed for 
reading on screens include Georgia, Cambria and Constantia. However, there 
is no such thing as an “accessible font” that works for everybody, even if that 
is sometimes claimed. Users with reading- and writing difficulties have just as 
individual preferences to fonts as other users. Good readability is important 
to all users, and even more when reading on a small screen or in bad light 
conditions, as well as essential for people with visual impairments and reading 
and writing impairments. 

• Typography. Avoid italics and text in capital letters. Line lengths should ideally 
be in the range of 80 characters. Avoid splitting words at the ends of lines. Do 
not use justified text. This is important for all users but even more for people 
with reading and writing impairments. 

• Use high-contrast colour combinations. Colour contrast can be checked using 
tools such as the TPGi Colour Contrast Analyser (for Microsoft Windows and 
Mac OS). This is important for all users but essential for people with visual 
impairments including colour blindness and reading- and writing impairments. 

• Make sure that colour is not the only distinguishing feature. Use other 
distinguishing details also (e.g.: do not only make a link blue, but also 
underline it). This is important for all users, but essential for people with 
visual impairments including colour blindness and cognitive disabilities. 

• Provide closed captions for video and transcripts for audio content. This is 
very useful for all users, not only for people who speak another language, but 
essential to hard of hearing users. Always use closed captions that can be 
switched on and off by viewers. This is important to make sure the captions 
do not disturb people who struggle with focus and concentration. Open or 
“burned-in” captions are always present and therefore may disturb some 
users. Closed captions may also allow for styling options to cater for user 
preferences. 

• Provide audio description for pre-recorded video. A video typically conveys 
information through the images also, not only via speech. It is important that 
blind and visually impaired students have access to such useful information. 
Therefore, videos should have an audio description (in a separate audio 
track), that includes descriptions of all essential visual information in the 
prerecorded multimedia content. Similarly, make sure that you describe 

https://www.tpgi.com/color-contrast-checker/
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important visual elements included in your presentation, be it a video or 
images. 

• Make sure that all content and functionality can be accessed using the 
keyboard alone. This is essential for people who use assistive technology for 
input, for example devices for persons with motor impairments, and also for 
blind users with screen readers. 

5.2 Accessibility support for users 

The main features of Microsoft and other office type software include tools for 
persons with disabilities and instructions on how to enable accessibility support: 

● Accessibility support for Word (Windows, macOS, iOS, Android, Windows 
10 app and Web) 

● Accessibility support for PowerPoint (Windows, macOS, iOS, Android, 
Windows 10 app and Web) 

● Accessibility support for Excel (Windows, macOS, iOS, Android, Windows 
10 app and Web) 

● Accessibility features in PDFs (all platforms) 

● Accessibility support for Google Docs, Sheets, Slides & Drawings 
(Computer, Android, iOS) 

5.3 Basic guidance for creating accessible documents 

Below you can find resources on how to ensure accessibility features for your 
documents: 

• Make your Word documents accessible to people with disabilities (Windows, 
macOS, iOS, Android and Web) 

• Make your PowerPoint presentations accessible to people with disabilities 
(Windows, macOS, iOS, Android and Web) 

• Make your Excel documents accessible to people with disabilities (Windows, 
macOS, iOS, Android and Web) 

• Create and verify PDF accessibility in Adobe Acrobat Pro (Windows and Mac) 

• Make your Google Doc, Slides and Sheets more accessible (Windows and 
Mac) 

• Creating accessible ePubs (Accessible ePub Guide, Guide to create an 
accessible ePub, WordToEPUB for Windows) 

https://support.microsoft.com/en-us/office/accessibility-support-for-word-c014d8b8-4ef3-4a7a-935d-295663f3343c#PickTab=Windows
https://support.microsoft.com/en-us/office/accessibility-support-for-word-c014d8b8-4ef3-4a7a-935d-295663f3343c#PickTab=macOS
https://support.microsoft.com/en-us/office/accessibility-support-for-word-c014d8b8-4ef3-4a7a-935d-295663f3343c#PickTab=iOS
https://support.microsoft.com/en-us/office/accessibility-support-for-word-c014d8b8-4ef3-4a7a-935d-295663f3343c#PickTab=Android
https://support.microsoft.com/en-us/office/accessibility-support-for-word-c014d8b8-4ef3-4a7a-935d-295663f3343c#PickTab=Windows_Mobile
https://support.microsoft.com/en-us/office/accessibility-support-for-word-c014d8b8-4ef3-4a7a-935d-295663f3343c#PickTab=Windows_Mobile
https://support.microsoft.com/en-us/office/accessibility-support-for-word-c014d8b8-4ef3-4a7a-935d-295663f3343c#PickTab=Web
https://support.microsoft.com/en-gb/office/accessibility-support-for-powerpoint-9d2b646d-0b79-4135-a570-b8c7ad33ac2f#PickTab=Windows
https://support.microsoft.com/en-gb/office/accessibility-support-for-powerpoint-9d2b646d-0b79-4135-a570-b8c7ad33ac2f#PickTab=macOS
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5.4 Checking that content is accessible 

It is always advisable to check the accessibility of your material before using it. Below 
you can find some basic information on how to use the built-in accessibility testing 
tools in the Microsoft Office suite and in Adobe Acrobat. Please, be aware that these 
steps can change with time, however, the following instructions might serve as 
indications even then. 

5.4.1 Accessibility checker in Word 

1. Select File > Info. 

2. Select the “Check for Issues button” in the “Inspect Document” area.  

3. Click the “Check Accessibility” command to launch the task pane. 

4. Or type in “Accessibility checker” in the Search field. 

5. A list of “Errors” and/or “Warnings” may appear. 

6. In recent versions, the tool is also available using the “Check Accessibility” 
button in the Review tab. The button also offers direct access to more 
accessibility tools, like the Alt Text Pane, the Navigation Pane for document 
structure overview, and the ‘Focus’ immersive view, and to the Accessibility 
settings. 

5.4.2 Accessibility checker in PowerPoint 

1. Select File > Info. 

2. Select the “Check for Issues button” and choose “Check Accessibility”. 

3. In the Check for Issues drop-down menu, select Check for Issues. 

4. Or type in “Accessibility checker” in the Search field. 

5. Select the “Review tab”, then choose “Check Accessibility”. 

6. In recent versions, apart from the Accessibility checker, an Accessibility tab 
also opens up automatically, offering further accessibility tools, like the Alt 
Text Pane, the Reading Order Pane, an “Inspect without Color” function, the 
spell checker, subtitles/captions tools and others. 

7. In recent versions, the tool is also available using the “Check Accessibility” 
button in the Review tab. The button also offers direct access to the Alt Text 
Pane, the Reading Order Pane, the Accessibility settings and an Accessibility 
help. 
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5.4.3 Accessibility checker in Excel 

1. Select File > Info. 

2. Select the Check for Issues button. 

3. In the Check for Issues drop-down menu, select Check for Issues. 

4. Or type in “Accessibility checker” in the Search field. 

5. The Accessibility Checker task pane appears next to your content and shows 
the inspection results. 

6. In recent versions, apart from the Accessibility checker, an Accessibility tab 
also opens up automatically, offering further accessibility tools, like the Alt 
Text Pane, spell checker, selected formatting tools, naming tools and an 
Accessibility help. 

7. In recent versions, the tool is also available using the “Check Accessibility” 
button in the Review tab. The button also offers direct access to the Alt Text 
Pane, the Format as Table style shortcut, the Unmerge Cells command, the 
Accessibility settings, and an Accessibility help. 

5.4.4 Accessibility checker in PDF (Acrobat Pro) 

1. Open the document. 

2. Add the Accessibility Tool to your Toolbar: Click on the Tools Tab > Click the 
Add button below the Accessibility Tool. 

3. Return to Document View: Click on the Document Tab. 

4. Open the Accessibility Toolbar: Click on the Accessibility Tool in the Toolbar 
on the right side of the window. 

5. Run a Full Check of the document: Click on Accessibility Check in the 
Accessibility Toolbar on the right side of the window > Click on Start Checking 
to run the Accessibility Checker. 

6. View the results: 

a. The Accessibility Checker panel will be opened on the left side of the 
window. 

b. Click on each category to expand that section: 

7. A red X indicates that the test was failed. 

8. A blue question mark indicates that the test must be done manually. 

a. Some items can be fixed automatically by Acrobat, and some will need 
to be fixed manually. 
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b. Right-click on each item to see if they can be automatically fixed. 

9. If the item cannot be fixed automatically, click on Explain to open the item’s 
section in the Acrobat User Guide. 

10. You will find a description of the reported issue and directions on how to fix it. 

• Make sure that both the format and the content of your training materials 
are accessible. They should have a clear structure, a clear design, a clear 
language, and alternative presentations where necessary. And everybody 
should be able to navigate them, no matter their abilities. 

• Make your documents accessible. Check out the publicly available 
information on the accessibility features of the main document formats, on 
how to ensure that they are accessible and how to check whether they are. 
That way you can make sure that all your students have access to the 
information you provide in your documents. 

6 Teaching strategies 
Ensuring that training is accessible to all students, regardless of their abilities, is of 
paramount importance. This involves embracing the principles of Universal Design for 
Learning (UDL). 

Accessibility forms a core element of Universal Design for Learning, but UDL 
encompasses a broader range of considerations. Accessibility aligns with the first 
principle of UDL, which emphasizes the provision of multiple representations of 
information. This principle reflects the understanding that “if you cannot reach them, 
you cannot teach them”. In essence, it underscores the significance of 
accommodating diverse learning needs by offering information in various formats 
and modalities, thereby making education more inclusive and effective. 

Below are several tips for teaching an accessible course. These tips come from a 
variety of resources, including DO-IT’s “20 Tips for Teaching an Accessible Online 
Course”: 

• Make sure that course participants can see you well, especially your face and 
upper body. Adapt the lighting if necessary. 

• Make sure that course participants can hear you well. In a big classroom or a 
lecture theatre, the sound system needs to be adequate. 

https://www.washington.edu/doit/20-tips-teaching-accessible-online-course
https://www.washington.edu/doit/20-tips-teaching-accessible-online-course
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• When presenting visual information such as diagrams, graphs and flow charts, 
do so in such a way that course participants with vision impairments get all 
the visual information. 

• Make sure the content is presented in multiple ways. For example, when 
using a video, make sure it is captioned. A transcript is nice, however when 
you write, you present content differently than when presenting it in a video. 

• Acronyms and jargon should be defined (or avoided). 

• Instructions and expectations should be clear. 

• Make sure that examples and assignments are relevant to a diverse audience 
(older students, male vs female, from different disciplines). 

• Make sure that outlines and other scaffolding tools are provided. 

• Make sure to provide adequate opportunities for practice (sometimes 
optional extra materials for students who want to do a little bit more). 

• Provide adequate time for activities, projects, and tests (for example, you can 
ask the program manager to open the class one week before it starts, so 
students can get ahead, in case they get too busy later). 

• Provide feedback on parts of an assignment (if it is a bigger assignment). 

• Provide options for communicating or collaborating. 

• Provide options for demonstrating learning (sometimes there are options for 
the same task, sometimes a multiple-choice test, sometimes creating a video). 

• Consider recording the lecture, so that students can listen to it again later. 

• Follow the principles of Universal Design for Learning. 

• Make sure, all students get all the information. 

• Engage your students with a varied set of tools and assignments, in a way 
that can be adjusted to their needs. 

• Provide different options and ways for students to demonstrate their 
knowledge. 
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7 Training formats 

The recommended usage of the training material ranges from the combined use of 
modules in a single workshop to an extended and more comprehensive training 
course. It is essential to tailor the content to align with the specific requirements, 
existing knowledge, and interests of the target audience, following a learner-centred 
approach. 

These training materials are adaptable for both online and on-site training and can 
also be effectively employed in a blended format. Below, trainers can find an 
illustrative example of how to structure a single workshop and create a 
comprehensive training package using the provided content. 

Trainers are advised to allocate ample time for interactive and engaging learning 
activities, practical exercises, foster reflection and evaluation, and incorporate well-
established educational methods such as brainstorming and focus groups, among 
others. 

Moreover, the design of learning activities should take into consideration the diverse 
needs and abilities of all participants. 

7.1 Example 1: Workshop 

The training material can be used in a workshop setting (e.g., 100 minutes training), 
to raise awareness and to provide an introduction and an overview to the subject of 
user testing with persons with disabilities. The section numbers in parenthesis 
indicate the relevant parts of the training material. 

Introduction (10min) 

 Share the learning objectives for the workshop. 

 Encourage the audience to participate and share their experience. 

Part 1: Foundations (10min) 

 Outline the necessity of digital accessibility. (section 1.1) 

 Provide an overview of user needs. (sections 1.1, 1.3) 

 Explain why it is important to involve persons with disabilities in user testing. 
(section 1.2) 

Part 2: Diversity (15min) 

 Provide important aspects for recruiting users with diverse user needs. 
(sections 2.1-2.3) 

 Explain the importance of providing support and guidance. (section 2.4) 
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Part 3: Communication (40 min) 

 Discuss how to communicate respectfully with users with disabilities. 
(section 3.1) 

 Show examples of inclusive materials and set-up. (sections 3.2-3.5) 

 Work in groups: each group sets up a testing scenario. 

 Discuss the groups’ work. 

Part 4: Assistive technology (10 min) 

 Give examples of assistive technology (AT). (section 4.1) 

 Discuss the importance of considering AT in user testing. (sections 1.2, 2.4, 
4.2) 

Part 5: At the end of the test (10 min) 

 Outline how to finish a test session. (sections 5.1-5.2) 

 Highlight the importance of compensation. (section 5.3) 

 Discuss how to give feedback. (section 5.4) 

Conclusion (5 min) 

 Summarise the key points of the workshop. 

 Provide additional resources for participants who want to learn more. 

7.2 Example 2: Detailed training course 

The training material can be used for a detailed training course (e.g., 8-15 units, 
60-90 minutes per unit), aiming to reach an in depth understanding of the topic, with 
emphasis on both theoretical, and practical knowledge transfer. The section numbers 
in parenthesis indicate the relevant parts of the training material. 

Unit 1: Introduction 

 Allow participants to share their experience and their user needs. 

 Share the agenda and the learning objectives for the training. 

 Discuss expectations, wishes, needs, and interests. 

 Assess the knowledge of your training group on user testing and accessibility. 

Unit 2: Accessibility and user needs 

 Outline the necessity of web accessibility. (section 1.1) 

 Go through the most important terms and definitions. (section 1.1) 
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 Discuss accessibility needs related to various disabilities. (sections 1.2-1.4) 

 Show real-world examples of accessibility issues. (sections 1.1, 1.3) 

Unit 3: Accessible testing environment and flexibility, recruitment 

 Explain recruitment basics (disability, assistive technology, age, gender etc). 
(sections 2.1-2.3) 

 Discuss how to best reach testers. (section 2.2) 

 Show examples of testing environment. (sections 2.3-2.4, 3.5)) 

Unit 4: Inclusive and respectful communication 

 Discuss key items of disability etiquette. (section 3.1) 

 How would you feel if someone spoke to your companion instead of to you? 

 How do you feel when someone refers to you as “the shy/tall/bald person” or 
similar? 

 How would you react when people you do not know come too close or start 
touching your things? 

 How do you feel when someone makes assumptions about your abilities? 

Unit 5: Inclusive test materials and alternative formats 

 Discuss pros and cons of different types of test materials (physical and digital). 
(section 3.2) 

 Describe alternative formats and how to produce them. (section 3.3) 

 Explain the need for support and guidance. (section 3.4) 

Unit 6: Assistive technology 

 Describe assistive technologies that affect mobility and orientation (coming to 
the test-centre, entering the building). (section 4.1) 

 Describe assistive technologies that have an impact on the room. (section 4.2) 

 Describe assistive technologies that have an impact on the test. (section 4.2) 

 Discuss work arounds and problem solving related to assistive technology in 
the test situation. (section 4.3) 

Unit 8: Conclusion of the test, feedback, and compensation 

 Describe how to end a test session. (sections 5.1-5.2) 

 Discuss the need for compensation. (section 5.3) 
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 Outline good practices for providing feedback to testers. (section 5.4) 

Unit 9: Practice 

 If possible, let students set up a user test with real users who are informed 
about the context. 

 Let the pilot testers provide feedback to students. 

 If that is not possible, let students practice what they have learned by setting 
up tests and testing each other. 

Unit 10: Summary, Conclusion & Assessment 

 Recap the key points of the training. 

 Provide additional resources for participants who want to learn more. 

 Assessment of the acquired knowledge. 

8 Background information for the training modules 

There are many different reasons behind teaching UX-students user testing with 
persons with disabilities, for example political, philosophical, legal, economical, 
moral… As an introduction to discussing this, we have provided a couple of examples: 

8.1 Examples of background perspectives 

1. Opening Doors to Job Opportunities for Students 

The European Union’s Web Accessibility Directive, established in 2016, and the 
European Accessibility Act, passed in 2019 (to be implemented across the EU in 
2025), have heightened the need for expertise in accessibility. For many Information 
and Communication Technology (ICT) products and services marketed within the 
European Union, accessibility is shifting from being an option to a requirement. 
Familiarizing students with web accessibility equips them with the skills to develop 
accessible ICT products. European standards will mandate that ICT products and 
services adhere to accessibility guidelines. Consequently, understanding how to test 
with users with disabilities has advantages that extend beyond the realm of ICT, even 
for those not legally obligated to prioritize accessibility. 

2. The Power of Designing for Everyone 

Some inventors who contributed to the typewriter’s development, such as Agostino 
Fantoni and Pellegrino Turri of Italy, and Charles Thurber of the United States, 
aspired to create a device that enabled blind individuals to write. Dean Kamen’s work 
on the iBOT, a self-balancing powered wheelchair, served as the foundation for the 
Segway. OXO’s Good Grips kitchen utensils were designed to cater to a broad 
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spectrum of users, including those with arthritis and low vision, and have garnered 
popularity among a wide audience. Similar advantages can be found in the digital 
domain. 

3. Embracing Diversity and Complexity in Design 

In IT and design education, the business case is not the sole rationale for teaching 
inclusive design. Teaching inclusive design equips students to address conflicting 
priorities, such as "exploring and solving, simplicity and universality, provoking and 
respecting, feeling and testing, expression and meaning." These seemingly 
contradictory priorities, as noted by Graham Pullin, provide a means to control force, 
position, and direction. Jutta Treviranus, from the Inclusive Design Research Centre in 
Toronto, Canada, has authored valuable articles on this subject. For example, 
"Preparing a next generation that understands the value of human diversity and can 
navigate complexity" (July 16, 2019) and "Inclusive Design: The Bell Curve, the 
Starburst, and the Virtuous Tornado" (April 22, 2019). 

4. Designing for Our Future Selves 

With age, individuals commonly encounter age-related functional limitations. 
Contrast sensitivity diminishes from the age of 40, hearing impairment becomes 
more prevalent after 50, and motor skills may decline, often after 50, due to 
conditions like arthritis and Parkinson’s Disease. Accessibility affects not only people 
with disabilities and retirees but also a significant portion of the workforce. It is 
important to note that even those who do not categorize themselves as "disabled" or 
"people with disabilities" eventually experience impairments as they age. This data 
underscores the fact that accessibility is not only relevant to specific groups but also 
to a broad demographic, including our future selves. 

8.2 Strategies and methodologies for teachers 

Teachers may increase motivation and understanding through: 

• activities that help better understand the diversity of user needs; 
• combining theory with practice. 

1. Engage in learning activities that courage students to develop a broad 
understanding of the variety of users and user needs 

To be able to develop and design accessible products and services, ICT professionals 
need to consider the varying needs of different users. This means challenging 
preconceptions about who is the user and what are the user needs. A central part of 
developing both an understanding of accessibility and the ability to implement 
accessibility in design and development is therefore to learn about a wide variety of 
users and user needs. This can be done in several ways, ranging from working with 
personas to meeting and working together with persons with different abilities. 
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2. Invite persons with disabilities to collaborate on the course and engage with the 
students 

The best way to get an understanding of whether an interface work for all users in 
practice is to learn from people that know about accessibility challenges from their 
own experience and who can show what works and what does not work for them in 
different digital interfaces. Depending on the level of ambition, the interaction can be 
everything from a lecture to assignments where the students are working in teams 
together with persons with disabilities. 

3. Combine theory with practice: Integrate practical assignments at different levels 
in the courses 

User testing with persons with disabilities is not a purely practical subject. It involves 
both understanding the rationale for and the principles behind different user needs 
and assistive technology, as well as the ability to apply these principles in practice. 
Theory and practice go hand in hand, and teaching both together reinforces the 
learnings and helps to develop application strategies that will be useful for the 
students in their professional life. 

4. Provide and discuss good practice and bad practice examples 

Using existing examples is a good way to connect practice and theory, to explain 
concepts and to provide points of orientation. It helps to understand what to avoid 
and what to strive for in inclusive user testing. Students then can combine these 
examples and create their own solutions. Practices can be best exploited, if they are 
not only explained by the trainer, but also discussed by the students. 

5. Connect training on user testing with persons with disabilities to the student’s 
other courses to ensure that the courses together prepare students to practice 
inclusive design in their professional role. 

Web accessibility is always practiced within specific professional contexts. While 
there are core competencies common base of learning, connect learning activities to 
the students’ concrete ability to implement techniques for accessibility in interfaces. 
The practical ability can be defined differently according to the subject of the course. 
It could for example concern to develop and design products that are accessible, or 
to apply criteria of accessibility in procurement procedures. The important factor 
here is that accessibility needs to be practiced to make an impact. Concretely, this 
means that the content of the lessons in web accessibility should include examples 
and exercises that relate to the specific study programme followed by the students. 
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8.3 Assessing and strengthening the capacity for delivering courses 

1. When developing and delivering a module on accessibility, incorporate 
accessibility in the teaching material and delivery 

Students learn by example and practicing what you preach is the best way to get the 
message across. Accessibility is to its nature a practical concept, and a skill to be 
applied also in educational situations. It does not only concern the digital materials 
used in the courses, but also in general the way in which information is packaged and 
provided to students. This impacts everything from digital presentations to handouts 
and materials. 

2. Use student surveys to assess and fine-tune the web accessibility modules and 
courses 

Student surveys are useful to gather information for the development and fine-
tuning of courses and modules. Handing out a survey in preparation of the course to 
assess the level of knowledge among students will help you set the right level of the 
course for this particular group. The information can also be compared with a survey 
after the course was completed, to evaluate how much the students learned. 

3. Web accessibility in relation to other courses: Make the connection to 
accessibility in all relevant teaching topics 

Accessibility is important to all users of digital interfaces and IT, which means that 
whatever your students end up working with in the future, they will need basic 
knowledge of how user needs interact with accessibility issues. In addition, it is easier 
to learn and remember new concepts when they connect to issues that are familiar 
and recurring. Therefore, introducing basic accessibility principles and concepts in the 
context of general teaching on subjects such as interface design, service design or 
development techniques will both facilitate the student’s assimilation of the topic, 
and also make the learnings easier to remember and use in practice. 

4. When asking students to assess the course or module on accessibility, be sure to 
connect the course or module to the objectives of the overall ICT programme 
that the students follow 

The assessment of the courses is best done using the same means that are applied to 
all courses and programmes. This is to be able to compare the assessment with 
evaluations of other modules that are included in the ICT programme or course. From 
a didactic point of view, it is important to send a signal to both the teachers and 
students that web accessibility is not a specialist subject, but a normal part of all ICT 
education. Using the same evaluation methods, for example surveys, across all 
subjects ensures that the results of the evaluation can be taken into account in the 
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context of further developing the broader ICT programmes, together with other 
courses and modules. 

5. Networking with colleagues and external contacts: Join forces with colleagues to 
create a working group on accessibility 

Implementing accessibility is always teamwork – all web professionals that work with 
a specific interface need to apply accessibility principles that are relevant to their 
expertise, whether it has to do with design, development or content. The equal 
repartition of responsibilities is also a strength, as a team can provide both more 
incentives and support to work with accessibility. The same principle can be applied 
to teaching. Web accessibility should be included in all subjects that are core to ICT 
students, whether they are studying 19 design, development or communication. In 
this context, teachers within different disciplines can benefit from cooperating on 
developing courses and modules. Within the IWAC project, partner organisations 
successfully tried joint workshops where teachers responsible for different courses 
colleagues met up to learn more about accessibility through the MOOCs created in 
the project. These kinds of workshops could be expanded to regular meetings for 
mutual support and inspiration. 

8.4 Suggested methods to involve students 

The following section contains indications and examples for methodological 
approaches to approach learners and teach the modules and units: 

1. Open discussion & self-reflection 

• What do you know about [digital accessibility]? 

• What springs to mind when you hear the expression [accessible user testing]? 

• Why is [flexibility] important? 

• Discuss [common user needs and accessibility issues] 

• Reflect on personal experiences 

• Discuss the influence of [Assistive Technology usage] 

• Use a collaborative document, e.g. a FAQ (Frequently asked questions) 

2. Familiarise participants with the topic 

• Provide participants with a comprehensive overview 

• Explain the purpose, importance, advantages of [inclusive user testing] 
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3. Practical sessions 

• Discuss / present examples 

• Set up an inclusive user testing session 

• Pique your students’ interest by offering perspectives on why inclusive user 
testing is relevant for their professional future. 

• Provide practical assignments and first-hand experience, not only theory. 

• Connect the course on inclusive user testing to other elements in the 
students’ curriculum, integrating it into the overall ICT programme. 

 


	1 Introduction
	1.1 Target audience
	1.2 A flexible approach to learning
	1.3 Set-up of training modules
	1.4 Face to face or online

	2 Disability etiquette
	2.1 What is disability etiquette
	2.2 Be Attentive
	2.3 Guidelines for Social Interactions
	2.4 Words and Terminology
	2.5 Inclusive Language and Images

	3 Face to face training: considerations for accessibility
	3.1 Ensuring access to the venue
	3.2 Inside the building
	3.3 Setting up the room

	4 Online training
	4.1 Video conferencing and collaboration tools
	4.2 Conducting an online training

	5 Accessible training material
	5.1 Information formats
	5.2 Accessibility support for users
	5.3 Basic guidance for creating accessible documents
	5.4 Checking that content is accessible
	5.4.1 Accessibility checker in Word
	5.4.2 Accessibility checker in PowerPoint
	5.4.3 Accessibility checker in Excel
	5.4.4 Accessibility checker in PDF (Acrobat Pro)


	6 Teaching strategies
	7 Training formats
	7.1 Example 1: Workshop
	7.2 Example 2: Detailed training course

	8 Background information for the training modules
	8.1 Examples of background perspectives
	8.2 Strategies and methodologies for teachers
	8.3 Assessing and strengthening the capacity for delivering courses
	8.4 Suggested methods to involve students




